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AMS Field Data Review Checklist
Time Period of Data: ___________________ to _____________________________
F Review Monthly Spreadsheets
F Combine Spreadsheets to One File

File: __________________________________________________________
F Field Cleaner

Table: ___________________________________# of rows: _____________
Notes: ________________________________________________________
F Data Stacked in JMP

Notes: _______________________________________________________
File (txt):______________________________________________________
yyyyDataQA.accdb
Table: _________________________________# of records: _______________
F Duplicates Results without Depth
F Crosstab Query:

____
____
____

10
300
other: ___________

F Duplicates for Results
F Minimum of Date/Time

Table: ________________________________
Total # of Sampling Events: __________

F Range of Results
F Null Values
F Comments Field
F Results by Station
F Random Sample Set‐ hard copy review

____% of Data, ______# of Sampling Events, _____ # of Data Reviewed
Files (txt): ____________________________________________________________
Non‐recorded: _________ No Hard Copy: _________ Non‐Matching: ____________
Notes: _______________________________________________________________
# of Records: ___________________
Other Comments: _______________________________________________________
Review Completed Date: ______________________ by: ________________________
Field Data Review Checklist_201110.docx

AMS Field Data Review and Finalization
Field data are entered by regional monitors into a regional monthly field data spreadsheet
saved as yyyy_mm rRO.xls. Regional spreadsheets are reviewed when received and
identified concerns (such as values out of range or missing values) are sent back to the
monitors for review and revision if necessary. This review process pulls the regional
monthly spreadsheets together and includes a more thorough review and check of the data.
Monthly Spreadsheets
(C:\AMS Everything Useful\Shared_AMS\Monthly AMS data summaries\yyyy)
Combine regional sheets into one excel file per month. Save file as yyyy_mm.xls.
Review monthly spreadsheet columns for missing data, typing errors, and miskeys.
Common errors:
Date: Not within time period or missing; format: yyyymmdd
Time: Odd times such as early morning and late night or missing; format: hhmm
Depth: Very high numbers or missing
Results: Out of normal range for parameter
Collector: Missing or wrong format (lastname firstinitial\lastname firstinitial)
Make changes or add missing data. This may require contacting monitors so they can check
their records. Also if you have received the corresponding lab sheets some data may be on
them.
Save file.
Combine monthly spreadsheets for time period reviewing usually by quarter or 4 month
interval. Review quarterly spreadsheet again to make sure no data are missing.
Save file as yyyy_month-month_Field.txt. (ex. 2011_Jan-Apr_Field.txt)
Field Cleaner
(C:\AMS Everything Useful\ Data Review)
Import txt file into FieldCleanerB.accdb
When importing change date/time fields to text fields and parameter fields to numberdouble. You will want Access to add a primary key (autonumber).
Name imported data table- tblyyyy_month-month_Field
Once imported review table especially check date/time fields for correct format.
Delete all RAMS Visit IDs (begin with R instead of V) from table
Append recent Visit IDs to tblCurrentVID with qappVisitIDsToCurrentVID.
Open qappVisitIDsToCurrentVID in design view.
Change the critieria to the month(s) and year associated with the Visit IDs to be added.
!Run Query. (Note: tblVisitID is linked from the Labsheet database)
Open table tblToBeCleaned- Clear old data by highlighting all rows and selecting delete
records.
Append new field data to tblToBeCleaned
Open design view of append query- qappAddTotblToBeCleaned.
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Add new table to query- Query Tools> Design Tab> Show Table.
Change Table source in query fields to new table and then remove old table from query.
**Make sure you have changed all applicable columns or you may end up losing a
column when you remove the old table.
!Run query- should say appending ## of rows
Check table tblToBeCleaned to make sure all data were included and no columns were lost.
!Run macros mcrRunErrorChecks- enter start date, end date for time period of field data
being reviewed.
Check table tblErrors.
Go through table to verify or change errors generated by macros.
Main errors will be: Mismatch VID, Duplicate VID, Bad date/time, Duplicate Record, and
Null Header Info.
Append records back to main table by running- qappFixedErrorsToMainTable.
Rerun mcrRunErrorChecks until satisfied that no more changes need to be made.
Append records back to main table each time after checking errors.
Stacking Data in JMP
(C:\AMS Everything Useful\ Data Review)
Open JMP.
Open Stack Field Data Script- StackFieldDataRev.JSL
You will be asked to select which table to open –select tblToBeCleaned.
Check the final table that pops up especially the date/time field.
Save file as yyyyField_month-month.txt. (ex. 2011Field_Jan-Apr.txt)

**The SQL StackFieldDataRev should stack the field data for you but if not here are the
directions.
Open JMP
Open Database Table- Connect to Access- find FieldCleanerB.accdb/tblToBeCleaned
Check imported data especially dtmdatetime for blanks. Delete extra date/time fields.
Stack Tables
Table>Stack
Without depth- stack columns= 20, 32, 35, 36, 45, 78, 1351
Stacked Data column= result
Source Label column= methodcode
Click Stack
Delete other method code columns
Table>Stack
With Depth- stack columns= 10, 94, 300, 400, 480
Stacked Data Column= result
Source Label Column= methodcode
Click Stack
Delete other method code columns
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Concatenate Results tables
Tables>Concatenate
Place both of the newly created tables into selected data table
Click Concatenate
Check newly created table with both “without depth” and “with depth”.
Tables>Summary
Group by results, statistics by N
Select rows with “.” in result
Delete selected rows from concatenated table.
Save joined table as yyyyField_month-month.txt. (ex. 2011Field_Jan-Apr.txt)
**This completes JMP process.
Open text file in Excel to check for “.” in fields- Depth, Comments, Collector, etc. This also
keeps time in 24hr format when imported into Access.
Save file.
Data QA
(C:\AMS Everything Useful\ Data Review\yyyy\yyyyDataQA.accdb)
Import saved text file (yyyyField_month-month.txt) into database.
Change the following fields to the listed data type: Date/Time- text, result/depth- double,
methodcode- long integer
Have Access add a primary key (autonumber).
Name imported data table- tblyyyyField_month-month. (ex. tbl2011Field_Jan-Apr)
Once imported review table especially check date/time fields for correct format.
Add a field for Month (strMonth) to the table. Save Table.
Import updated tblCurrentVID from FieldCleanerB.mdb into database.
Update the month column in data table through an update query using tblCurrentVIDqupMonthToData
Check for duplicate Results without Depth
Create a find duplicates query that looks for duplicate visit ID, methodcode.
Review duplicates- this will be for rows with depth.
Change criteria in depth field to “is null” to check data without a depth.
Review duplicates. Make changes if necessary and delete duplicate rows due to depth
profiles.
Make Crosstab Query
Row Heading- Station, Methodcode
Column Heading- Month
Count(result)
!Run query
Change criteria in query to run for individual method codes
Such as 300- Dissolved Oxygen
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10- Water Temperature
Check each query to see if the correct number of results show up for each month. If there are
discrepancies then verify there is no result for that station that month. Update missing or
incorrect entries.
Check for duplicate Results
Create a find duplicates query that looks for duplicate visit ID, methodcode or duplicate visit
ID, methodcode, depth, or duplicate visit ID, methocode, depth, result.
Review and make necessary changes.
Minimum of DateTime field
Create a query with Visit ID, station and dtmDateTime(min).
Change query type to make-table query
Name table- tblField_month-month_MinDT
!Run Query- will ask if you want to append to new table- click yes.
Update DateTime to Minimum DateTime
Make a backup copy of field data table- save as tblyyyyField_month-month_Copy.
Create an update query with table tblField_month-month_MinDT and Field data table
tblField_month-month. Relate tables by strVisitID.
Use DateTime field from Field data- update to minOfdtmDateTime field.
!Run query
Check Range of Result values- (This is done in basic check of monthly spreadsheets but
another look does not hurt.)
Create a query with max, min and count of results for each method code
Columns- methodcode, displayname, result(count), result(min), result(max)
Look for appropriate ranges of data, i.e. at or above detection limits, decimal places
Check for null values
Create a query with each column in the results table included. In the criteria start on the first
line for the first column and type “is null”. Continue this for the other columns except the
comments and depth fields but go down one line each time. This should let you know if
something is missing.
Check Comments field
Review comments- remove any unnecessary comments that should not carry on with the
data.
Convert “LDO” to “Luminescence based DO sensor” for dissolved oxygen readings.
Compare Results by Station to previous 5 years of data
Create a min, max, count table for each station by methodcode based off the historical data
(last 5 or so years). (current table tblStationDataRanges_2006-2010)
Compare min/max to new data.
Open design view of qryCompareResultsToMinMaxField
Add new data table (tblField_month-month) to query and change Table source to new table
-then remove old table from query.
Create relationships between tables to include stationcode=strStation and
methodcode=methodcode.
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!Run Query
Review results that have a “!!!” in either the min or max column against the spreadsheets to
check for typo’s. Correct typo’s and check spreadsheets or with monitors for other
outrageous results that don’t seem reasonable.
Random Sample Set- compare against field data hard copies
Open the table tblyyyyField_month-month in JMP
Tables> Summary
Group by VisitID, station, datetime, collector
Statistics- blank
Create a random subset from the summary table
Tables>Subset>Random sampling rate- enter a % (eg 0.05). Percentage will depend on
number of results and feasibility to review. Click- Link to original data table.
Save subset table as Subset of ‘tblyyyyField_month-month’ RandomReview.txt
Select all records in the subset table. Go back to the original table tblyyyyField_monthmonth in JMP and create a subset table from the selected rows.
Tables>Subset>Selected rows
Click- Link to original data table.
Save subset table as Subset of ‘tblyyyyField_month-month’ RandomReviewData.txt.
This table will include the individual data points related to the first random subset table.
Split the data from the selected rows subset table for reviewing convenience.
Tables>Split
Split columns- result
Split label column- methodcode
Group by- strVisitID, strStation, dtmDateTime, dblDepth
Check “Keep all remaining columns”
Click Ok.
Rearrange order of methodcodes to match field data spreadsheet.
- 94, 10, 300, 400, 20, 480, 45, 32, 36, 1351, 35, 78
Save as Subset of ‘tblyyyyField_month-month’ RandomReviewData_Split.txt
Open table in Excel and format for review purposes.
Open file Subset of ‘tblyyyyField_month-month’ RandomReview.txt in Excel.
Sort sampling events by regional office and format table.
Save file as Subset of tblyyyyField_month-month_#.xls. (ex. Subset of tbl2011Field_JanApr_60.xls)
Send email to regional office monitors and request copies of the original hard copies for the
selected sampling events.
Review field data hard copies against file Subset of ‘tblyyyyField_month-month’
RandomReviewData_Split.txt. Note any values that were not recorded on the hard copy
but appear in the electronic version, no original hard copy could be found, and those where
the hard copy version does not match the electronic version.
Remove values that were not recorded on the hard copy or no hard copy is available. Revise
values to hard copy versions for those that do not match.
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AMS Lab Results Review Checklist
Time Period of Data: _________________ to _______________________
F Review Key Station Data

File: _____________________________________________________
F Lab Cleaner

Table: _________________________________ # of rows: _______________
Notes: _________________________________________________________
_________________________________________________________
F Data Stacked in JMP

____________ (stacked) ‐ ____________ (blank) = ______________ Records
Notes:_________________________________________________________
File (txt):_______________________________________________________
yyyyDataQA.accdb
Table: _____________________________________ # of records: _____________
F Crosstab Query:

____
____
____
____

82079
610
530/1040
other: ______________

F Duplicates for Visit IDs, DateTime
F Duplicates for Results
F Null Values
F Remark Codes
F Comments Field
F Range of Results
F Results by Station
F Random Sample Set

______% of Data

Other table/query names: ________________________________________________
# of records: _______________________
Other Comments: ________________________________________________________
_______________________________________________________________________
Reviewed Completed Date: _____________________ by: ________________________
AMS Lab Results Review Checklist _201110.docx
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AMS Lab Results Review and Finalization
Lab data from hard copy lab reports are entered by the ESS Processing Assistant into an
Access database (R:\Key Station\Data Entry_20100611.mdb). Data are pulled from the
database and saved on the ESS server (R:\Key Station\Data Entry Backups\Key
Station_yyyymmdd.xls) and AMS Coordinator’s computer (C:\AMS-Everything
Useful\Key_Station_ Data\DATAENTRYthruyyymmdd.xlsx). Revised versions of the
data pulls are saved with rev at the end of the file name
(DATAENTRYthruyyymmddrev.xlsx).
Key Station Data
(C:\AMS-Everything Useful\Key_Station_ Data)
Review columns for missing data, typing errors and miskeys.
Common errors:
Visit ID: Missing V or wrong number of digits, other fields entered
Station Numbers: wrong amount of digits, other fields entered
Lab Numbers: extra digits, other fields entered
Date: not within time period, no date*, format: yyyymmdd
Time: Odd times such as early morning and late night, no time; format: hhmm
Depth: Very high numbers, no depth
Results: Out of normal range for parameter or letters entered
Remarks: Numbers instead of letters or remarks codes that don’t exist
Make changes based on lab sheets. Contact Chemistry Lab for odd values or qualifiers.
Review lab data by station to check that all lab sheets for the time have been entered.
This will be checked again later in the review process but a check here will reduce having
to repeat the process and ensure all data have been received and entered.
Need to change date field format in Excel. Do this by adding an extra column and making
the original column a text column. Format the new column as =mid(cell,5,2)&”/”&right(cell,2)&”/”&left(cell,4). Copy this column then paste special
as values. Delete extra column.
Save file as yyyy_month-month_Lab.txt (ex. 2011_Jan-Apr_Lab.txt) in C:\AMSEverything Useful\Data Review\yyyy Data Review.
Lab Cleaner
(C:\AMS Everything Useful\ Data Review)
Import file into LabCleaner.accdbWhen importing change all parameters to double and do not have Access add a primary
key.
Name imported data table- tblyyyy_month-month_Lab.
Once imported review table especially check date/time fields for correct format. Field
types should match fields in LabDataTBC
Delete old table tblCurrentVID.
Import updated table tblCurrentVID from FieldCleaner.mdb
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Open table LabDataTBC. Delete all records.
Append new lab data to LabDataTBC
Open design view of append query- addtoLabDataTBC.
Add new table to query- Query Tools> Design Tab> Show Table
Change Table source to new table and then remove old table.
**Make sure you changed all applicable columns or you may end up losing a
column when you remove the old table.
!Run query- should say appending ## of rows
Check table LabDataTBC to make sure all data were included and no columns were lost.
!Run macros mcrRunLabErrorChecks- enter start date, end date for time period of lab
data being reviewed.
Check table LabDataErrors.
Go through table to verify or change errors generated by macros.
Most errors will be Null header info, Bad date/time, Duplicate Lab #, Unknown VID,
Mismatch VID.
Append records back to main table by running- qappFixedLabErrorstoMainTable.
Rerun mcrRunLabErrorChecks till satisfied that no changes need to be made.
Append records back to main table each time after checking errors.
Stacking Data in JMP
Open JMP
Open Database Table- Connect to Access- find LabCleaner.accdb/LabDataTBC
Check imported data table. Delete extra “Date” and “Time” Fields.
Stack Tables
Results
Table>Stack
Stack Columns= methodcode (highlight all method codes by holding Ctrl and clicking on
each method code column)
Stacked Data column= results
Source Label column= methodcode
Output Table name: Results
Click Stack
Delete remark columns from new table
Remarks
Table>Stack
Stack Columns= methodcode rmk (highlight all method codes rmk by holding Ctrl and
clicking on each method codes rmk column)
Stacked Data Column= remark
Source Label Column= methodcode
Output Table name: Remarks
Click Stack
Delete result columns from new table
Find/Replace to remove rmk from method codes in methodcode column
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Join Remarks and Results tables
Check both tables for same # of rows
Tables>Join
Join Results with Remarks
By matching columns- Match Visit ID, Station, Lab Numb, DateTime, depth,
methodcode
Check Include non-matches from both tables
Select Output columns- from Results: Station, Visit ID, DateTime, Lab Numb, Depth,
Comments, Methodcode, Results, and From Remarks: Remarks.
Output Table name: JoinedResultsRemarks
Check # of rows in joined table, it should match the # in the separated tables.
Tables>Summary
Group by results, remark
Select rows with “.” in result and “ “ in remark
Delete selected rows from joined table
Save joined table as yyyyLab_month-month.txt (ex. 2011Lab_Jan-Apr.txt).
Open file into Excel in order to delete remaining “.” values and check depth values.
Save file. This keeps 24hr format for time field.
Data QA
(C:\AMS Everything Useful\ Data Review\yyyy\yyyyData QA.accdb)
Import saved text file (yyyyLab_month-month.txt) into database.
Change the following fields: DateTime- text and result - double number
No Primary Key is necessary.
Name imported data table- tblyyyyLab_month-month (ex. tbl2011Lab_Jan-Apr)
Review imported table for correct number of records and format.
Add a field for Month to the table. Save table.
Update the month column in data table through the update query, qupMonthToData,
using tblCurrentVID.
Make Crosstab Query
Row Heading- Station, Methodcode
Column Heading- Month
Count(Results)
!Run query
Change criteria in query to run for individual method codes
Such as 82079- Turbidity
610- Nitrogen NH3
1040- Dissolved Copper
80- Color
Check each query to see if the correct number of results show up for each month. If there
are discrepancies then verify there is no result for that station that month. Update missing
or incorrect entries.
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Find Duplicate Visit ID, DateTime
Create a query with Station, Visit ID, datetime. Set Properties for Unique Values to yes.
Save query as qryyyyyLab_month-month_Unique.
Create a find duplicates query based off the just saved query.
Check for duplicate Visit ID’s with different datetime, same station duplicate datetime
with different Visit ID’s, etc…
Correct mistakes so that each Visit ID is associated with the correct station for one
datetime.
Check for duplicate Results
Create a find duplicates query that looks for duplicate visit ID and methodcode.
Check for null values
Create a query with each column in the results table included. In the criteria start on the
first line for the first column and type “is null”. Continue this for the other columns
except the remarks and comments fields but go down one line each time. This should let
you know if something is missing.
Check Remark Codes
Make sure remark codes are valid and look over format for uniformity.
Convert pH text for methodcode 83 from “PH-“ to “SAMPLE PH=”.
Check Comments field
Move additional analysis such as 310(BOD) into stacked format. Create a new line and
copy station information, add methodcode and result. Delete information from comment
field.
Also review comments- remove any unnecessary comments that should not carry on with
the data.
Check Range of Result values
Create a query with max, min and count of results for each method code
Columns- methodcode, displayname, result(count), result(min), result(max)
Look for appropriate ranges of data, i.e. at or above detection limits, decimal places
Check Results by Station to previous 5 years of data
Create a min, max, count table for each station by methodcode based off the historical
data (last 5 or so years). (current table: tblStationDataRanges_2006-2010)
Compare min/max to new data.
Open design view of qryCompareResultsToMinMaxLab
Add new data table (tblyyyyLab_month-month) to query and change Table source to
new table -then remove old table from query.
Create relationships between tables to include stationcode=strStation and
methodcode=methodcode.
!Run query.
Review results that have a “!!!” in either the min or max column against the lab sheets to
check for typo’s. Correct typo’s and check with lab for other outrageous results that
don’t seem reasonable.
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Random Sample Set
Open the results table (tblyyyyLab_month-month) in JMP
Table>Subset>Random sample- pick a % (eg 0.05 or 0.025). Percentage will depend on
number of results and feasibility to review.
Save new table as a txt file- Subset of ‘tblyyyyLab_month-month’.txt. (ex. Subset of
‘tbl2011Lab_Jan-Apr’.txt)
Open txt file in Excel and print.
Check results against hard copy lab reports to make sure database matches the lab
reports.
Correct any changes.
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AMS Field and Lab Data into Results Database Checklist
Time Period of Data: ______________________ to ________________________
Field Data Table: _____________________________ # of records: ____________
Lab Data Table: ______________________________ # of records: ____________
yyyyDataQA.accdb
F One DateTime for Results
Notes: ______________________________________________________
______________________________________________________
F Combine Field and Lab Data

Table: _________________________________ # of records: ___________
F Add Collector to Lab Data
F Check Changes in Data due to JMP
F Calibration Sheet review

File: _________________________________________________________
# of sampling days: __________________
# of missing sheets: _____________# of records removed: _____________
Table:________________________________________________________
# of records:___________________
AMSData_be.accdb
F Backup Results Table
Notes: _________________________________________________________
Table: __________________________________________________________
F Link Combined Field And Lab Data Table
F Append Data into Main Results Table

Original # of results:
# of results Added: Total:
NCAMBNT:
NCSPST:
Final # of results:

_____________________
_____________________
_____________________
_____________________
_____________________

Other Comments: ______________________________________________________
Review Completed Date: ____________________ by: _________________________
AMS Field and Lab Data into Results Database Checklist
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AMS Field and Lab Data to Main Results Database
Data QA
(C:AMS Everything Useful\ Data Review\yyyy\yyyyData QA.accdb)
Check for one datetime for both lab and field data
Open query qryCompareDateTime_Lab-Field in design view.
Add both the new lab and field data tables to query- Query Tools>Design
Tab>ShowTable.
Create relationships between the tables to include strStation(Field) = Station(Lab),
strVisitID(Field) = VisitID(Lab), and Station(Lab) = strStoretNumb(tblStation).
Change table sources in query fields to match new tables and then remove old tables from
query.
**Make sure you have changed all applicable columns or you may end up losing
a column when you remove the old tables.
!Run query. This query will let you know which date times do not match in both the field
and lab data.
Check all “!!!” entries for the correct values. This will require reviewing field data and
lab sheets.
Common errors are:
Wrong date on lab sheet- can look at receiving date if there is a question
Wrong date in field data- monitor sampled on different date than originally
planned or miskeyed data.
Correct any mistakes.
To get minimum time for both Field and lab data – add a field for MinDateTime:
iif([DateTime]< [dtmDateTime], [DateTime], [dtmDateTime]) Save as a table.
Create an update query to update all the data (field and lab) to the minimum value.
Combine Field and Lab data
Copy Lab data table and change name of table to tblyyyy_month-month (ex.
tbl2011_Jan-Apr).
Add a field for Collector to new table (tblyyyy_month-month). Save table.
Create an append query to append the field data(tblyyyyField_month-month) to table
tblyyyy_month-month. The field types will need to match in both tables.
!Run query- will ask if you want to append to table- click yes.
Add Collector to Lab data
Create a make-table query with unique values for Visit ID, Station, DateTime, and
Collector from field data table (tblyyyyField_month-month).
Name table- tblyyyy_month-month_Unique (ex. tbl2011_Jan-Apr_Unique).
!Run query.
Create an update query with Unique Value table (tblyyyy_month-month_Unique) and
combined data table (tblyyyy_month-month).
Create relationships between the tables with VisitID field.
Select Collector field from tblyyyy_month-month- update to unique value collector
field. Enter criteria- “is null” for the Collector field (updates only blank fields).
!Run query.
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Samples without VisitIDs, dissolved metals, and QC samples will need to be updated
manually.
Round depth field
JMP likes to change the number of decimal points for depth and results- may need to
round fields- Create Update query- update depth field to round([depth_m],1)
!Run query
Calibration Sheet Review
Open query qrySamplingDatesByRegion in design view.
Add table tblyyyy_month-month to query- Query Tools>Design Tab>ShowTable.
Create relationships between the tables to include Station(combined) =
strStoretNumb(tblStation).
Change table sources in query fields to match new table and then remove old table from
query.
**Make sure you have changed all applicable columns or you may end up losing
a column when you remove the old tables.
!Run query. This will provide a list sampling dates by collector for the time period
reviewed.
Copy table to Excel and paste special as text.
Save as yyyy_month-month_CalibrationCompare.xls (ex. 2011_JanApr_CalibrationCompare.xls).
Open Calibration database (S:\Calibration Resources\ Calibration Logs) and query
qryUniqueRegionCollectorDateMeter. Enter dates start date and end date for time
period of data review.
Copy and paste table into yyyy_month-month_CalibrationCompare.xls in columns
next to the values from yyyyData QA.mdb. Go through spreadsheet and match entries.
Add spaces to the appropriate fields when matching values are not included. This could
be due to no calibration sheet for a sampling event or no AMS sampling event for a
calibration sheet since the calibration database has all sampling events including AMS.
Review rows with blanks especially sampling events without calibration sheets. Contact
regional monitors about missing calibration sheets and if available, add information to
database and spreadsheet.
Once all available calibration sheets are entered, review the reports for DO, specific
conductance, and pH.
When post-sampling checks were not completed, not within QC accept criteria, or no
calibration sheet is available, then data for associated dates, stations and parameters are
flagged in the comments field of tblyyyy_month-month with “to be removed”.
Review hard copy calibration sheets to verify failure.
Create a make table query with tblyyyy_month-month. Pull all fields and under the
Comments field add the criteria “to be removed*”.
Name the new table – tblyyyy_month-month_ToBeRemoved.
!Run query.
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Once the data have been added to the new table, change the query type to delete query.
!Run query to remove associated data from table tblyyyy_month-month.

AMS Database
(C:AMS Everything Useful\ AMS data\AMSData_be.accdb
Backup Main Results Table
Copy the main Results table- tblResults
Save table. (example- tblResultspre2011JFMAData)
Import Combined Table
Export combined table tblyyyy_month-month as a tab delimited text file from
yyyyDataQA.accdb.
Import combined Field and Lab data table (tblyyyy_month-month) to database.
Append New Data to tblResults
Create an Append query- use the combined Field and Lab data table and tblCurrentVID.
May need to import or link tblCurrentVID to this database also. Connect the tables by
Visit ID and join properties to include all rows from combined Field and Lab data table
and only those in tblCurrentVID.
For agencycode column- the agency field will need to be created and assigned to
“NCAMBNT” or “NCSPST” depending on the criteria (see below). Add station number,
DateTime, depth, methodcode, result, remark, collector, comment fields from combined
field and lab data table. Match to fields in tblResults
From tblCurrentVID- add lngSamplingCode.
NCAMBNT criteria
Currently all data except Chronic Special Studies

NCSPST criteria
StationVisitID- is null
!Run query
Check tblResults for new results and correct formatting.
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